Creating Single-Subject Design Graphs
With Microsoft Excel 2000 (rev. 6-5-06 – added printing directions)

Creating a Comparison or a Reversal Design Graph

Usually, a comparison design graph will only have two conditions: Baseline and intervention, whereas a reversal design will have multiple conditions, including a return to baseline condition. The basic graphing directions are the same in both cases. In this example, a reversal design graph is illustrated. However, if it were a comparison design, we would only have data for one baseline and one intervention condition (as opposed to two of each), but the graphing procedure itself would be the same.

1. Entering the data into the spreadsheet

   - Enter the time element in which you are collecting your data (e.g. Days, Weeks, Sessions, Months, etc.) in the first column.
   - For each behavior you are plotting, enter the data in the column to the right of the previous column. Enter the data in a consecutive manner, regardless of condition phase (i.e. Baseline, Intervention), so that the total for each day, week, session, month, etc., are next to the appropriate time element number (ex. if there were 14 incidents of throwing self on floor on day 4, make sure that 14 is to the right of 4). See Fig. 1
   - Note: If you are missing data for some days, weeks, sessions, months, etc., simply leave the corresponding behavior data cell blank. Step 8 will direct you as to what to do in this case to ensure that all data points within your graph are connected.

Figure 1
2. Creating the graph: Chart type

- Step 1: Using your mouse, select the cells containing all the data.
- Step 2: After the data are selected, click on the chart wizard icon (symbolized by a blue, yellow, and red bar graph).
- Step 3: In **Standard Types** tab, select **XY (Scatter)** chart type;
- Step 4: Click on the bottom left chart sub-type: **Scatter with data points connected by lines**.
- See **Fig. 2**

![Microsoft Excel chart wizard interface with selected data and chart types](image)

**Figure 2**

- Click on the **Next** Button.
3. Creating the graph: Data range

- The string of coordinates for the selected data will appear. Make sure that the string represents the correct data range.
- See Fig. 3

**Figure 3**

- Click on the **Next** Button.
4. Creating the graph: Graph title and axes labels

- A preview window will appear offering you a chance to alter features of the graph (e.g., Titles, Axes, Gridlines, Legend, Data Labels).
- In the **Titles** tab, enter the title for the X [Value (X) axis] and Y axes [Value (Y) axis] (e.g. days and frequency, respectively)
- If you wish to change the title above your graph, you may do so by entering it under **Chart title**
- See Fig. 4

![Figure 4](image-url)
5. Creating the graph: Gridlines

- Once you have entered the titles, click on the **Gridlines** tab and un-click the **Major gridlines** box (this will remove the gridlines on the graph)
- See Fig. 5
6. Creating the graph: Legend

- If you are graphing only one behavior and you have the name of the behavior at the top of the graph (as is the case in this example), you do not need a legend. To delete the legend, go to the Legend tab and un-click Show legend.
- See Fig. 6
- Note: If you were graphing several behaviors, you would want to leave the legend in, and you might want to label your graph something more general (such as Joe’s behavior). You can do this under the Titles tab, by changing the Chart title (refer back to #4, Figure 4).

Figure 6
7. Creating the graph: Finish the graph
   - Once all changes have been made, click on the Next button.
   - This will open up a new window (Step 4 of 4 – Chart Location)
   - Select As Object In – Sheet 1
   - See Fig. 7
   - Click on the Finish button

![Figure 7](image)

- Click on the graph and drag it with the mouse to place it where you want it to appear.
- At this point the graph should be complete and embedded in the spreadsheet.
8. Customizing the graph: If you have data missing

- If you have data missing for certain days, weeks, sessions, etc… (in our example, suppose that we did not have any data for days 7 and 18) all data points in your graph will not be connected, as some cells have been skipped. (If you do not have data points missing, skip this step.)
- To ensure that all data points within a data series are connected click on the graph
- Click on Tools on your tool bar, and select Options
- This will open and Options window, with several tabs. Go to the Chart tab
- Under the Active Chart section, select Interpolated. This will connect all data points.
- See Fig. 8

![Figure 8](image-url)

- Once you are done, click OK
9. Customizing the graph: Format axes

- To format an axis, you need to double-click on the axis itself. A **Format Axis** window will appear, with the following tabs: Patterns, Scale, Font, Number, and Alignment.
  - Under Patterns you can change the axis line, and the lines between the markings
  - Under Scale you can change how often you want the numbers to appear and how far you want the axis to go
  - Under Font you can change the font of the numbers
  - Under Number you can change the type of number this is (e.g. date, percent, etc.)
  - Under Alignment you can change the way that the numbers line up on the axis

- Most of the time you will only need to change the scale, as the other items will appear as you want them to be. However, if you wish to change any of those items, simply click on that tab and make the changes.

- In our example graph, we should change X-axis scale so that numbers appear more frequently than every 5 numbers, and we need to shorten the range so that it ends with our last data point (day 20) as opposed to day 25.
- Select the **Scale** tab. A series of default values will appear.
- Select how often you want the numbers to appear by changing the value on **Major unit** (we will select 1 for every day)
- Select the maximum number you want the axis to display by entering it under **Maximum** (we want day 20, so we will enter 20)
- See **Fig. 9**

![Figure 9](image_url)

- Once you are done, click **OK**
10. Customizing the graph: Format graph area

- To remove the gray background color and the right border from the graph, click on the graph itself
- Double click on the shaded background of the graph
- A Format Plot Area window with a Patterns tab will appear
- Under the Border section, select None
- Under Area section, click on the white square
- See Fig. 10

Figure 10

- Click on the OK button
11. Customizing the graph: Format data series

- If you want to change the color or the marker of a data series, for instance if the data series appears in yellow you might want to change it to a different color that will be more visible, double-click on the data-series that you want to change
- A Format Data Series window will appear, with several tabs. You want to select the Patterns tab
- To change the color of a data series: on the right-hand side, under the Marker section, click on the pull down menu for Foreground and select the color that you want; Do the same for Background. On the left hand side, under the Line section, click on the pull down menu for Color and select the same color.
- To change the marker shape: On the right-hand side, under the Marker section, click on the pull down menu for Style and select the marker shape that you want
- See Fig. 11

![Figure 11](image)

- Click on the OK button
12. Customizing the graph: Un-connect data points

- In order to insert a condition line, you should first remove the data series line that connects the two data points from different conditions (e.g. baseline and intervention)
- To remove the line:
  - Click on the first data point of the next condition (e.g. first data point for intervention) – this will highlight the entire data series
  - Click on the same data point again – this will highlight the data point that you clicked and the one before it
  - Double-click on that same data point, and a Format Data Point window will appear (make sure it says Format Data Point and not Format Data Series)
- On the left-hand side, under the Line section, select None
- See Fig. 12

Note: If you have removed a line and need to put it back, follow the same procedure but select Automatic under the Line section – This will re-connect the data points

Figure 12

- Click OK. This will remove the line between the data points. Repeat the same procedure for all the lines you want to remove (for each condition change)
13. Customizing the graph: Insert condition lines

- To draw the condition lines, click on the Line tool from the Drawing toolbar. This will turn your cursor into a cross. Place the cross where you want the line to begin. Click, hold, and drag the left mouse button to draw the line.
- Repeat this for each condition line.
- See Fig. 13.

- If you need to move the line, click on the line (a square will appear at each end). You can then click on the line and move it by dragging it with the mouse, or you can just move one end of the line by clicking on the square and dragging it.
- If you wish to change the way the line looks (e.g. to make a dotted line), click on the line, then double-click on the line. A Format AutoShape window will appear. There you can select different styles and weights for the vertical line.
14. Customizing the graph: Insert condition labels

- To insert the condition labels, click on the Text Box tool from the Drawing toolbar. This will turn your cursor into a vertical line with a small horizontal line at the bottom. Place your cursor where you want the text box to be. Type the label that you want (e.g. Baseline).
- Repeat this to label each condition.
- See Fig. 14

- If you need to move the text box, click on the text – a box will appear around the text. Click on the box. You can then click and drag the box to where you want it.
- If you need to re-size the text box, click on the text – a box will appear around the text. Click on the box. You can then place your cursor over any of the little squares around the box and click and drag to re-size the box.
- If you wish to change the way the text box looks (e.g. place a border, change the font, etc.), click on the text – a box will appear around the text. Double-click on the box. A Format Text Box window will appear. There you can select font, colors and lines, etc.

![Image of Excel graph with Text Box tool and custom labels]

Figure 14
15. Completed reversal design graph

The reversal graph is now complete and the graph should look similar to the one in Fig. 15.
Creating a Multiple Baseline Design Graph

A multiple baseline design graph is essentially a series of comparison design graphs that are connected by condition lines.

To create a multiple design graph, follow the steps for creating a comparison design for each separate "leg" (e.g. each comparison graph of the multiple baseline design) that you are creating. At the end, you should have two or three separate comparison graphs.

1. Entering the data into the spreadsheet

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph (in this case, each leg will represent a different behavior)
- See Fig. 16

<table>
<thead>
<tr>
<th>Days</th>
<th>Physical Expression</th>
<th>Tantrum Behavior</th>
<th>Writing Self</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>14</td>
<td>16</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>15</td>
<td>14</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>14</td>
<td>16</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>14</td>
<td>13</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>9</td>
<td>7</td>
<td>11</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>8</td>
<td>12</td>
<td>13</td>
</tr>
<tr>
<td>16</td>
<td>9</td>
<td>16</td>
<td>15</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>8</td>
<td>14</td>
</tr>
<tr>
<td>12</td>
<td>11</td>
<td>9</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>12</td>
<td>7</td>
<td>8</td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>16</td>
<td>15</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>17</td>
<td>16</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>18</td>
<td>17</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>19</td>
<td>18</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>20</td>
<td>19</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>21</td>
<td>20</td>
<td>3</td>
<td>1</td>
</tr>
</tbody>
</table>

![Intervention data in yellow](image)

Figure 16
2. Creating the graph: Chart type

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph
- See Fig. 17

Figure 17
3. Creating the graph: Data series/range

- Once you click Next, the graph will depict the three behavior series since these were all selected in the data range. Since you want to make 3 separate graphs (i.e. legs), one for each behavior, you will need to repeat step 2 (above) three times, and each time you will need to remove two data series from each graph.
- To remove a data series, click on the Series tab; in the Series area, click on the series you want to remove, and click on the remove button.
- See Fig. 18

![Microsoft Excel - Single Subject Graphs (6-12-04)](image)

**Figure 18**

4. Creating the graph: Graph title and axes labels

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph, however:
- Only select a chart title for the leg that will be placed at the top (not for any of the other ones)
- Only select X-axis labels for the leg that will be placed at the bottom of your multiple baseline design graph.
- If Y-axis labels will be the same for all legs (e.g. Frequency) do not select any Y-axis labels. You can later label the Y-axis by placing a text box there.

![Select data series to remove](image)

![Click](image)

Intervention data in Yellow
5. Creating the graph: Gridlines
   - Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph

6. Creating the graph: Legend
   - Remove all legends from each graph. Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph.

7. Creating the graph: Finish the graph
   - Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph
   - Place each leg of the multiple baseline graph in the correct display order
   - Make sure that all the graphs line up
   - Your graphs should now look similar to those in Fig. 19

8. Customizing the graph: If you have data missing
   - Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph
9. Customizing the graph: Format axes

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph. **Make sure all the graphs have the same scale and font for both the X and Y axes, even if you later remove the labels.**
- Only the last leg of your multiple baseline design should have the X-axis number labels.
  - To remove the number labels for the other legs, double-click on the X-axis. The **Format Axis** window will appear, select **Patterns**, under the **Tick mark labels** section select **None**.
- See Fig. 20.
10. Customizing the graph: Format graph area

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph
- You will also want to remove the border around each graph.
- To remove the border around each graph, double-click on the chart area. A Format Chart Area window will appear. In the Patterns tab, under the Border section, select None.
- See Fig. 21

![Figure 21](image)

11. Customizing the graph: Format data series

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph

12. Customizing the graph: Un-connect data points

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph
13. Customizing the graph: Insert condition lines

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph for each leg of your multiple baseline design graph, however,
- Stretch each condition line so that it goes to the next graph.
- Connect each condition line with horizontal lines (using the Drawing tool)
- See Fig. 22
14. Customizing the graph: Insert condition labels, behavior labels, and axis label

- Follow same steps as illustrated under Creating a Comparison or a Reversal Design Graph
- Use the text box tool to insert a text box to label the conditions only at the top of the graph
- Use the text box tool to insert labels for each behavior:
  - Format each text box so that it has a border around it by clicking on the text box, then double-clicking on it so that the Format Text Box window appears. In the Colors and Lines tab, under the Line section, select Color – Automatic, from the pull down menu
- Use the text box tool to insert a label along the Y-axis:
  - Click on the text box and then double-click on it to format it:
  - Under the Alignment tab select the text orientation and the alignment so that the text is vertical and centered;
  - In the Colors and Lines tab, under the Fill section, select the white square from the pull down menu
- See Fig. 23

![Figure 22](image-url)
15. Completed multiple baseline design graph

- The multiple baseline design graph is now complete and the graph should look similar to the one in Fig. 23.
Printing and Pasting Graphs

Once you have created your graph in Excel, you may want to either print it directly from Excel, or copy it and paste it into another document, such as a Word document.

To print your graph directly from Excel:

1. **Select the Print Area**
   - Using your mouse, place your cursor at the top left hand side of the graph, so that a fat cross appears. Click the left mouse button and drag it down to the bottom right hand side of your graph, so as to select the entire graph. You will see a border appear, surrounding the area selected.
   - Click on the **File** tab, scroll down to **Print Area**, and click on **Set Print Area**
   - See Fig. 24

![Figure 24](image-url)
2. **Preview Printed Graph**

- Once you have selected the area to be printed, make sure that your graph looks like what you want before printing it.
- Click on the **File** tab again, scroll down and click on **Print Preview**
- See **Fig. 25**
- This will bring up a blank page with what your printed graph would look like
3. **Format Printed Page**

- Look at what your printed graph would look like.
- Depending on your graph, you may need to center it, shrink it, or enlarge it.
- To do so, click on the **Setup button** at the top of the screen.
- This will open up a window, named **Page Setup**, where you can make the necessary changes.
- See **Fig. 26**

- Note: If at any time you would like to exit this view and go back to your Excel spreadsheet, simply click on the **Close** button at the top of the screen.
4. **Center your graph**

- In the Page Setup window, under the **Margins** tab, you can change the size of the margins of your printed page by clicking up or down to make them smaller or larger.
- In the Margins tab, you can also center your graph on the page by selecting both **Horizontally** and **Vertically** under **Center on page**.
- See Fig. 27
5. Make sure the graph fits on the page

- In the Page Setup window, under the Page tab, you can change the size of the graph, as well as the orientation of the paper. Depending on the type of graph that you have and on its original size, you may or may not need to make any changes.
- If you would like your graph to fit onto one page, you can select Fit to 1 page and the program will shrink or enlarge the graph by the necessary percentages so that it fits onto one page (within the margins that you have set).
- See Fig. 28
- Once you are done making the necessary changes in the Page Setup window, click on the OK button.
- This will close the Page Setup window, and your graph will appear as it will be printed.
- If this does not look like what you would like to have printed, go back into the Page Setup window and make changes as needed.

Figure 28
6. Print your graph

- Once you are ready to print your graph, got to the top of the screen and click on the **Print** button.
- See Fig. 29

![Print button](image)

**Figure 29**
- This will bring you back to the Excel spreadsheet, and a window with your printer’s information will open
- See Fig. 30
- Click OK, and your graph should print!
To paste your graph onto another document such as Word or PowerPoint:

1. Remove the gridlines
   - In order to paste your graph without the spreadsheet lines showing up, you will need to first remove them.
   - Click on the **Tools** tab, and then click **Options**
   - See Fig. 31

![Figure 31](image-url)
- An Options window will appear
- In the View tab, unclick **Gridlines**
- Click **OK**
- See **Fig. 32**
- This will remove the spreadsheet lines

Figure 32
2. Select the copy area

- Using your mouse, place your cursor at the top left hand side of the graph, so that a fat cross appears. Click the left mouse button and drag it down to the bottom right hand side of your graph, so as to select the entire graph. You will see a border appear, surrounding the area selected.
- Click on the Edit tab, scroll down and click on Copy
- See Fig. 33
3. Paste graph into another document

- Go to the place in the other document where you want to paste your graph.
- Click on the Edit tab, scroll down and click on Paste Special
- See Fig. 34

![Figure 34](image-url)
- This will open up a **Paste Special** window
- Select **Bitmap**
- Click **OK**
- See Fig. 35
- Your graph should now be pasted onto your document!
• Your graph should now be pasted onto your document!
• See Fig. 36
4. **Modify pasted graph**

- You will be able to move your pasted graph and make it smaller or larger, as if it were a picture, but you will not be able to go into the graph itself and modify it.
- To move the graph or to change the size, simply click on it, and move it or modify it with your mouse.
- See Fig. 37